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Deep Freeze Security Notice

Deep Freeze does not protect against booting from a floppy drive or CD-ROM drive. The CMOS should 
be configured to prevent booting from the floppy drive or CD-ROM drive (i.e. set to boot to the hard 
drive) and the CMOS must be password protected. This is a normal precaution for most public access 
computers. The Windows Registry, the computer CMOS and the boot sector are protected by Deep Freeze 
from within Windows.

Technical Support

Every effort has been made to design this software for ease of use and to be problem free. If problems are 
encountered, contact Technical Support:

Email:   support@faronics.com

Phone:  800-943-6422 or 604-540-8199

Hours:  8:30am to 5:00pm (Pacific Time)

Contact Information

Web:  www.faronics.com

Email:  sales@faronics.com

Phone:  800-943-6422 or 604-540-8199

Fax:  800-943-6488 or 604-540-8179

Hours:  8:30am to 5:00pm (Pacific Time)

Address: Faronics Technologies USA Inc.
  Suite 170 – 2411 Old Crow Canyon Road
  San Ramon, CA 94583
  USA  
  Faronics Corporation
  Suite 202 – 145 Schoolhouse Street
  Coquitlam, BC V3K 4X8
  Canada

©1999-2004 Faronics Corporation. All rights reserved. Deep Freeze, FreezeX and WINSelect are trademarks and/or 
registered trademarks of Faronics Corporation. All other company and product names are trademarks of their respective 
owners.
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Deep Freeze Overview

About Deep Freeze

With over four million installations, Deep Freeze has a proven track record of non-restrictive, complete 
Windows protection. Deep Freeze provides network administrators with a simple and 100% successful 
method of maintaining desktop systems and reduces software technical support to an absolute minimum. 
Deep Freeze is completely invulnerable to hacking and makes computing environments easier to manage 
and maintain. Each restart eradicates all changes and resets the workstation to its original state right down 
to the last byte.

Deep Freeze Enterprise Components

Deep Freeze uses different colored icons to represent the functions of its components.

Files identified by a red icon should generally only be installed on an administrator computer.

 
  The Deep Freeze Enterprise installation file.

 The Configuration Administrator application—used to create a customized, pre-configured  
  workstation installation program file, Workstation Seeds, the Enterprise Console, and   
  generate One Time Passwords.

 The Enterprise Console application—used to centrally deploy, monitor, manage, and   
  maintain Deep Freeze workstations.

Files identified by a yellow icon should generally only be installed on a workstation computer.

 A pre-configured workstation installation program file that is used to install Deep Freeze
  on workstations.

 A pre-configured Workstation Seed used to Target Install Deep Freeze from the Enterprise  
  Console.

Files identified by a computer network icon should generally only be installed on an administrator 
computer.

 A file used to install and manage the Deep Freeze Enterprise Server Service that allows   
  Remote Console operation.
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System Requirements

The Deep Freeze Configuration Administrator and the Enterprise Console require Windows 2000 or XP to 
function properly. Deep Freeze requires Windows 95/98/Me/2000/XP and 10% free hard drive space.

New Features

Deep Freeze Enterprise Version 5 offers several new features and benefits, including:

• Single install for Windows 95/98/Me/2000/XP
• Ability to image Deep Freeze as part of a Windows 2000/XP master image
• NTFS ThawSpace of up to 100GB
• Option to retain existing ThawSpace on Windows 2000/XP
• Disable keys on Windows 2000/XP workstations during Scheduled Maintenance
• Message box on workstation during Scheduled Maintenance when keys are disabled
• Consolidated Deep Freeze Command Line control for Windows 95/98/Me/2000/XP
• Dynamic configuration update using the Enterprise Console
• Support for installing critical updates to Windows 2000/XP automatically during the Maintenance
  period either via the Internet or an SUS (Microsoft Software Update Services) server

About Faronics

Faronics develops and markets workstation protection management solutions for multi-user computing 
environments. Since 1989, Faronics’ proven solutions have made information technology professionals 
and computing lab managers more effective by ensuring 100% availability of workstations, dramatically 
reducing workstation management and maintenance, and increasing user satisfaction. Faronics’ flagship 
solution, Deep Freeze, protects over four million workstations worldwide. Educational institutions, 
libraries, government organizations, and corporations benefit from Faronics’ user driven and powerful 
technology innovations.
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Deep Freeze Configuration Administrator

The Configuration Administrator is intended to only be installed on the computer that will be used 
to administrate Deep Freeze. It is used to create a customized Deep Freeze installation program pre-
configured with passwords, schedules, and other options, Workstation Seeds, the Enterprise Console, the 
Server Service Manager, and generate One Time Passwords.

Installation

Insert the CD-ROM from the media package into the CD-ROM drive. Select Install Deep Freeze 5 
Enterprise Administrator in the window that appears on the desktop.

If Deep Freeze has been downloaded via the Internet, double-click the file DF5Ent.exe to begin the 
installation process.

Follow the steps presented, then read and accept the licence agreement. Click Install and the Configuration 
Administrator will be installed on the computer.
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Initialization with a Customization Code

Open the Configuration Administrator by selecting the following path from the Start menu:

Start ➜	Programs ➜	Faronics ➜	Deep Freeze Enterprise ➜	Deep Freeze Administrator

The Deep Freeze Enterprise Customization window will appear the first time the Configuration 
Administrator is opened.

Deep Freeze requires a Customization Code to be created by the administrator. This code is not a password 
that can be used to access Deep Freeze. It is a unique identifier that completely encrypts the Configuration 
Administrator, the Enterprise Console, the workstation install program, the One Time Password Generation 
System, and Deep Freeze Command Line Control. The Customization Code will ensure that no other 
administrators can access or control a workstation. Multiple Deep Freeze administrators controlling the 
same group of workstations should use a matching Customization Code.

Enter a Customization Code to complete the initialization of the Configuration Administrator. The code 
must be at least eight characters long and may consist of any combination of alpha-numeric characters.

The Customization Code must be recorded and guarded with care. Faronics is unable to 
recover a lost or forgotten Customization Code!

Re-Initialization

A new Customization Code can be assigned to the administrator computer by running the DFInit5.exe 
program in the Deep Freeze Enterprise folder.

Once a new Customization Code has been assigned, the Configuration Administrator will no 
longer work with previously configured installations. To work with previous installations, 
use the DFInit5.exe program to reset the Customization Code back to its original settings.
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Using the Configuration Administrator

The Configuration Administrator is used to create a customized Deep Freeze installation program pre-
configured with passwords, schedules, and other options.

There are five main tabs for accessing the various options available: Welcome, Start Here, Configuration, 
One Time Passwords, and Create Programs. 

Toolbar

The Toolbar is available at the top of every tab in the Configuration Administrator. There are five buttons 
that provide convenient access to some of the most commonly used functions.
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File Menu

The File Menu contains similar options to those on the Toolbar with the addition of Password Protection 
and shortcuts for Create Server Console, Create Server Manager, Create Workstation Seed, and Create 
Workstation Install Program.

Password Protection offers another layer of security for the administrator. Use this screen to optionally 
password protect access to the Deep Freeze Configuration Administrator application.

Start Here

The Start Here tab provides a brief description of how to perform some common tasks with the 
Configuration Administrator.
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Configuration

The Configuration tab has eight sub-tabs along the bottom used to configure various options. 
A customized workstation installation program file is ready to be created after all of the desired 
configuration options have been selected. This program file will be used to install a pre-configured version 
of Deep Freeze on workstation computers.

Passwords

Deep Freeze Enterprise allows the administrator to choose up to 15 passwords that work in addition to the 
One Time Password Generation System.

Check Enable on the appropriate line to create passwords. Enter the password, select the type, and select 
whether it is user-changeable. Scroll down to add up to 15 passwords.

Passwords can be assigned for use at a workstation (WKS) or for use with the Command Line Controls 
(CMD). The Command Line Controls will not function unless at least one CMD password is defined.

The User Change checkbox can only be used with WKS passwords. Selecting this option allows the user to 
change the password at the workstation.

Passwords can optionally be set to expire at a specified date. Checking Enable to the right of a password 
will cause that password to be activated on the Activation date and to expire at midnight on the Expiration 
date.
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Frozen Drives

The Frozen Drives tab is used to select which drives are to be Frozen (protected by Deep Freeze) or Thawed 
(unprotected).

Checked drives will be Frozen by Deep Freeze. Check Freeze all Fixed Drives and all the drives will be 
Frozen.

All of the drive letters are shown because the pre-configured installation may be installed on many 
workstations with various hardware and software setups. In the example above, the C: drive is checked, but 
not the D: drive. This will result in all workstations with only a C: drive being Frozen. Workstations with a 
D: partition or drive will have a Frozen C: drive and a Thawed D: partition or drive.

Only local drives (partitions or physical drives) can be Frozen. Deep Freeze cannot Freeze removable 
media drives or network drives.

External USB or FireWire hard drives are mounted as local fixed hard drives. If all fixed 
drives are Frozen, all external hard drives will be Frozen as well.

USB flash drives are treated as removable media drives and cannot be Frozen.
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Restart/Shutdown

The Restart/Shutdown tab is used to schedule restarts or shutdowns.

Check Enable Restart/Shutdown Schedule to enable the schedule and select the appropriate options for each 
day of the week.

Check Set One Change All to apply a change made for one day of the week to all other days.

Check Enable Idle Restart/Shutdown to configure the number of minutes required before the workstation 
automatically performs a restart or shutdown during periods when there is no keyboard or mouse activity. 
The workstation will only restart once after the Idle time has expired. Keyboard or mouse activity is then 
required to restart the Idle timer.

A dialog box will appear on the workstation indicating that the workstation is about to restart or 
shutdown. The user has the option the cancel the restart or shutdown and continue working.

Only one Restart/Shutdown per day can be scheduled. If the workstation needs to be restarted on a more 
frequent basis, the Idle time restart should be used.
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Maintenance

The Maintenance tab is used to schedule a time when Deep Freeze is Thawed. During this Maintenance 
period, the workstation will be Thawed and available for upgrades, new installations, maintenance, or any 
other activity that requires permanent changes.

Check Enable Thawed Maintenance Schedule to enable the schedule and select the appropriate options for 
each day of the week.

 • Start Time - The time when the workstation will restart into the Thawed state.
 • Stop Time - The time when the workstation will restart into the Frozen state.

If the Stop Time precedes the Start Time, the Stop Time is assumed to be during the next day.

Check Set One Change All to apply a change for one day of the week to all other days.

Check Run Windows Updates to allow workstations to install critical updates to Windows 2000/XP 
automatically during the Maintenance period via the Internet.

Optionally check Use SUS server and specify the server’s IP address or server name in SUS URL to use an 
SUS (Microsoft Software Update Services) server instead of the Internet.

Microsoft SUS client can be downloaded at:
http://www.microsoft.com/windows2000/downloads/recommended/susclient/default.asp.

Microsoft SUS server can be downloaded by searching for SUS server at: 
http://www.microsoft.com.

The Run Windows Updates feature will not actually perform updates, but will make the call 
to have the normal update method take place during the Maintenance period.

http://www.microsoft.com/windows2000/downloads/recommended/susclient/default.asp
http://www.microsoft.com
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The Maintenance period must be at least five hours in duration for the Run Windows Updates feature 
to function. If a smaller duration has been entered, the following message will be displayed when Run 
Windows Updates is checked:

If this message is displayed, click No to uncheck Run Windows Updates or click Yes to automatically change 
the Maintenance period for each selected day to a five hour duration by adjusting the Stop Time.

Check Disable Keys to prevent the keyboard and mouse from functioning on the workstation during the 
Maintenance period. If this option has been checked, the workstation will display the following dialog 
during the Maintenance period:
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ThawSpace

The ThawSpace tab is used to create a virtual partition on a workstation that can be used to store 
programs, save files, or make permanent changes. All files stored in the ThawSpace will be saved after a 
restart, even if the workstation is Frozen. 

Check Include a ThawSpace to include the creation of a ThawSpace in the installation program. 

The Host Drive is the workstation drive that is the source for the ThawSpace virtual partition. It is 
automatically detected by Deep Freeze and cannot be changed.

The ThawSpace Drive option is used to select the drive letter assigned to the ThawSpace. The default letter 
is T:, but it can be changed to any available letter. The next available letter will be used if the selected drive 
letter already exists on a workstation when Deep Freeze is installed.

The Size option is used to select the size of the ThawSpace. The minimum space allowed is 16MB. 
Workstations running Windows 95, 98, or Me can host a maximum ThawSpace of 2GB. Workstations 
running Windows 2000 or XP can host a maximum ThawSpace of 100GB when using the NTFS file 
system or 4GB when using the FAT32 file system. If the workstation does not have enough free space to 
accommodate the selected ThawSpace size, the size of the ThawSpace will be adjusted downward to ensure 
proper operation of the workstation.

Workstations running Windows 95/98/Me must use the FAT16 file system for a ThawSpace. Workstations 
running Windows 2000/XP use the NTFS file system by default, but this can be changed to FAT32 by 
selecting the radio button.

Check Retain Existing ThawSpace to retain an existing ThawSpace on a Windows 2000/XP workstation 
when Deep Freeze is uninstalled. If the option to include a ThawSpace has also been checked, workstations 
with an existing ThawSpace will have the existing ThawSpace retained during re-installation. Deep Freeze 
will always display a dialog asking if the ThawSpace should be retained or deleted during an Attended 
Uninstall, regardless of whether Retain Existing ThawSpace has been checked.
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Network

The Network tab is used to configure the communications protocol that the Enterprise Console will use to 
communicate with a Workstation Seed or a Deep Freeze installation program file. 

Check the LAN radio button to configure Deep Freeze to communicate within a local area network (LAN). 
Check the LAN/WAN radio button to configure Deep Freeze to communicate in both a LAN and a wide 
area network (WAN).

LAN is a self-configuring mode that requires only a port number. The default port is 1971. The port 
number can be changed if it is in conflict with other programs on the LAN. In LAN mode, the Deep Freeze 
workstations and the Enterprise Console find each other through UDP broadcasts. These broadcasts only 
occur when workstations or the Enterprise Console are started, ensuring that there is little network traffic 
associated with workstation and Console communication.

LAN/WAN can be used in either a LAN or WAN environment and over the Internet. An IP and port 
number must be provided. On a single segment LAN or a multi-segment LAN with unique IP numbers, 
the static IP of the computer running the Enterprise Console must be entered.

No configuration of the network routers are required in most LAN environments.

When the Enterprise Console is behind a firewall or a NAT (network address translation) router, the 
firewall or router must be configured to allow traffic to pass through to the Enterprise Console. Depending 
on the firewall or router, workstations may need to be configured with the IP address of the firewall so that 
traffic can be forwarded.

These settings can be changed on local workstations using the Network tab.

For more information on configuring and using Deep Freeze in a specific network environment, refer to 
Appendix A—Network Examples or contact Technical Support.
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If a port number other than the default of 1971 is used, care should be taken to ensure that there 
are not conflicts with applications already running on the network. Well Known Ports (0–1023) 
should be avoided and any Registered Ports (1024–49151) should be checked for conflicts before 
deployment.

A complete listing of the ports assigned to various applications can be found on the Internet 
Assigned Numbers Authority web site at http://www.iana.org/assignments/port-numbers.

Win9x

The Win9x tab is used to configure options applicable only to workstations running Windows 95/98/Me.

Check Use Hard Reboot When Thawed to force workstations to perform an immediate restart when leaving 
the Thawed state. This option should be selected if the workstations experience problems shutting down 
when leaving the Scheduled Maintenance period.

Check Prevent Break Outs from “Autoexec.bat” if the Windows 9x workstations are using the autoexec.bat 
file to execute programs before Windows starts. This will prevent users from aborting the execution of the 
autoexec.bat file and gaining access to the system in an unprotected state.

http://www.iana.org/assignments/port-numbers
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Miscellaneous

The Miscellaneous tab is used to configure various other options. 

The Display Options checkboxes are used to select whether the Deep Freeze icon will be shown in the 
System Tray. The normal Deep Freeze icon indicates that Deep Freeze is installed and the workstation 
is Frozen. The Deep Freeze icon with a flashing red X indicates that Deep Freeze is installed but the 
workstation is Thawed.

The Frozen  or Thawed  icon is used to access the Deep Freeze logon dialog by holding down 
the SHIFT key and double-clicking the icon. If the Show Frozen or Show Thawed icons are unchecked 
in Display Options, and therefore removed from the System Tray on the workstation, the hot keys 
CTRL+ALT+SHIFT+F6 must be used to access the logon dialog.

The Allow User to Change the Clock checkbox can be used to allow Frozen users to adjust the system clock. 
This feature can only be used if there is no Maintenance Schedule set. Selecting this option will disable the 
Maintenance Schedule if one has been set.

The Disable Command Line Options checkbox is checked by default. Unchecking it will allow for further 
customization of the Deep Freeze installation program during installation using the Silent Install System. 
Checking it will prevent the pre-existing configuration choices from being changed during installation.
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Create Programs

The Create Programs tab is used to create customized Deep Freeze installation program files with all of the 
configuration options that were previously selected. It is also used to create the Deep Freeze Enterprise 
Console.

The Enterprise Console    can be used to centrally deploy, monitor, manage, and maintain Deep Freeze 
installations quickly and easily. The Console should only be installed on an administrator’s computer.

The Workstation Seed    is a small program that allows administrators to remotely install and control 
workstations from the Enterprise Console. The Workstation Seed can be installed as part of a master image 
and then deployed via imaging software. All workstations on the LAN with the Workstation Seed installed 
will be displayed in the Enterprise Console.

The Full Workstation Installation program    is used to install Deep Freeze on workstations using an 
Attended Install, the Silent Install System, or a Target Install. The Workstation Seed is included in this file; 
it is not necessary to install the Workstation Seed if the workstation is going to have the Full Workstation 
Installation program installed on it.

The Server Manager program    is used to install the Deep Freeze Enterprise Server Service. 

Click the appropriate icon to create an installation file. All files will be saved to the DF5 Install Programs 
folder within the Deep Freeze Enterprise folder by default. Alternate locations can be chosen and the file 
name can be changed if desired. It is recommended that a naming convention is used if the administrator 
is creating multiple customized installation files.
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One Time Passwords

The One Time Passwords tab is used to create a special temporary password to Deep Freeze that will expire 
at midnight on the day it was generated.

A One Time Password (OTP) can be useful if, for example, a Deep Freeze password is forgotten or if a 
configuration was created without any passwords defined. An OTP could also be used to provide access to 
a workstation for an individual performing maintenance duties without requiring that individual to know 
the permanent Deep Freeze password.

Select the Password valid for multiple uses radio button to create an OTP that will be valid for multiple uses 
during the current day. All OTP passwords will expire at midnight on the day they were created, regardless 
of type.

Enter the OTP Token from the workstation that requires the OTP into the Token field. Click the Generate 
OTP button to generate the OTP password.

The OTP Token for the workstation is located in the Deep Freeze logon dialog.

The OTP system is completely secure and encrypted by the Configuration Administrator.
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Uninstalling the Configuration Administrator

Open the Add/Remove Programs utility in the Windows Control Panel by selecting the following path from 
the Start menu:

Start ➜	Control Panel ➜	Add or Remove Programs

Select Deep Freeze Administrator - Enterprise and click the Change/Remove button. Follow the steps 
presented and the Configuration Administrator will be uninstalled from the computer.
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Deep Freeze Enterprise Console

The Deep Freeze Enterprise Console displays the status of all Frozen, Thawed, and Target workstations on 
the network and allows the administrator to perform specific tasks on those workstations. Detailed status 
information is available with selective or group reporting.

The Enterprise Console allows administrators to remotely perform the following tasks:

• Immediately Target Install workstations.
• Selectively Thaw one or more workstations.
• Selectively Freeze one or more workstations.
• Change passwords, schedules, and configuration on the fly.         
• Restart or shutdown workstations.
• Power on workstations equipped with a Wake on LAN network card.

The Enterprise Console can only wake a workstation from a powered down state if the 
workstation is properly configured to power on when a Wake on LAN packet is received.

Enterprise Console Activation

If the DF5Console.exe file is copied to a different workstation than the one it was originally created on, it 
will need to be activated before the Enterprise Console will operate. When the Enterprise Console runs for 
the first time on a workstation, a One Time Password will need to be generated.

The Enterprise Console will only run on Windows 2000 or XP. The computer on which the 
Enterprise Console will be installed must not have an installation of the Workstation Seed or 
a full Deep Freeze installation. 
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Enterprise Console Operation

Launch the Enterprise Console by double-clicking the DF5Console.exe file created by the Configuration 
Administrator.

In the example shown above, the area outlined in red lists any network domain or workgroup found on 
the local area network. The area outlined in green lists the workstations in the selected network or group 
and their status. The area outlined in yellow summarizes the status.
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Status Icons

The Enterprise Console displays the status of the workstations on the local area network with the 
following icons beside or above the workstation name depending on the view selected:

Workstations that have the Deep Freeze Workstation Seed installed but do not 
have Deep Freeze installed.

Workstations with Deep Freeze installed in a Frozen state.

Workstations with Deep Freeze installed in a Thawed state.

  
Workstations that are currently powered down.

Any workstation showing a small i beside the status icon is no longer 
communicating with the console.

Deep Freeze can only be remotely installed on workstations that display the Target icon.

A workstation can lose communication with the Console for a number of reasons:

• The workstation is powered off manually or is shutdown without warning.
• The network is experiencing heavy traffic or outages.
• The workstation’s network settings are changed to indicate a new Console.

In most cases, communication with the workstation will be re-established when the workstation is 
powered on or when the conditions causing the communications breakdown are rectified. It may take 
several minutes for the workstation to report back to the Console and re-establish communication. If 
communication cannot be re-established, contact Technical Support for troubleshooting steps.

View Options

The Enterprise Console has three view options: Icons, Detailed, and List. The current view can be changed 
using the View menu.

The View menu can also be used to view the log for all workstations or to remove the selected 
workstation(s) from the log.
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Managing Deep Freeze Using the Enterprise Console

The Enterprise Console contains a toolbar at the top of the screen that allows quick access to the functions 
of the Console.

These commands can also be accessed using the contextual menu by right-clicking on a specific 
workstation.

When a particular action is chosen, the selected workstation will perform the action and the status icons 
will update accordingly.

Specific icons will be disabled if the selected workstation does not support that action.
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Target Install Using the Enterprise Console

The Enterprise Console can remotely install a Full Workstation Installation on any workstation that has 
the Workstation Seed installed.

To install Deep Freeze on a workstation using the Enterprise Console, right-click on the workstation and 
select Install. Individual or multiple workstations can be selected.

A dialog box will appear asking if the installation should proceed. Click OK to present a dialog box used to 
select the file to install on the remote workstation.

After selecting the installation program to use, the workstation will install Deep Freeze and restart. Once 
the installation is complete, the workstation icon in the Enterprise Console will change to the Frozen polar 
bear icon.



30 

 

 31

Dynamic Configuration Update Using the Enterprise Console

To update the configuration on one or many workstation(s), right-click on the workstation(s) and select 
Update Configuration.

A Configuration window with five tabs, similar to the Configuration Administrator, will appear. The five 
tabs can be used to update the configuration on the remote workstation(s). For further information about 
the settings on each tab, refer to the sections in the Configuration Administrator documentation for 
Passwords, Restart/Shutdown, Maintenance, Network, and Miscellaneous.
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Click Load from file to load the settings from an existing .rdx file into the Configuration window. A 
standard open file dialog will appear that can be used to select a file.

Click Cancel to cancel the configuration update.

Click OK to update the configuration on the selected workstations.

When updating the configuration on the workstation, all of the displayed options will be 
updated using the new settings. Frozen Drives, ThawSpace, and Win 9x options cannot be 
dynamically updated and will remain as they were prior to the update.

If the Network options in the new configuration have changed, the workstations may 
lose communication with the existing Enterprise Console. If communication with the 
workstations is lost, check the Network settings on the updated workstations to ensure that 
the port numbers and/or IP address of the Console have not been changed.

Changes to passwords take effect immediately. All other changes take effect after the 
workstation is restarted.
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Network and Groups

The Enterprise Console automatically arranges workstations by their workgroup or domain. Click on the 
appropriate workgroup or domain to view the workstations in that workgroup or domain.

The Enterprise Console can be used to define specific groups to arrange workstations in. Right-click on 
the User Defined Groups folder and select User Defined Groups ➜	Add or click the User Defined Groups icon 
in the toolbar to setup a group.

Workstations can be added into the group by dragging and dropping them from the Workstations pane or 
by using an automatic filter set during the creation of the groups. 

Automatic group filtering allows workstations to be added to user defined groups automatically. The 
workstations are added based on their workstation (computer) name. Wildcards (*, ?) can be used to 
include a group of workstations based on a specific segment of the name. 

Example: Lab1-* will include all workstations that have a name starting with Lab1- into the user defined 
group.

Deep Freeze Control Console Log File

The Deep Freeze Enterprise Console keeps a log of the status and activity history of all connected 
workstations. The log stores information for the previous ten minutes only. Information older than 10 
minutes is automatically deleted from the log.

To view the log file for one or many workstation(s), right-click on the workstation(s) and select Show Log 
for Selected Workstations.

The log file can be sorted by any of the listed criteria by clicking on the appropriate heading.
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Uninstalling Using the Enterprise Console

The Enterprise Console can be used to uninstall Deep Freeze completely or to uninstall Deep Freeze but 
leave the Workstation Seed.

To uninstall Deep Freeze on a workstation and leave the Workstation Seed, right-click on the Thawed 
workstation(s) and select Uninstall - Leave Seed.

To completely uninstall Deep Freeze and the Workstation Seed, click the Uninstall button in the Toolbar.

The workstation must be Thawed before Deep Freeze can be uninstalled. The Enterprise 
Console will prompt for confirmation. Once the uninstall is confirmed, Deep Freeze will 
uninstall and the workstation will restart.
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Deep Freeze Enterprise Remote Console

Deep Freeze Enterprise incorporates the ability to communicate with workstations via a Remote Console. 
The Remote Console is a small utility that runs on a remote workstation and acts as a communications 
hub that other Consoles can connect to in order to control and view workstation status.

In the example above, the server at the district office is acting as the host for two Remote Consoles running 
on different ports (port 1490 and port 1500). Deep Freeze Console 1 can see all workstations reporting 
into the server because it is connected to both Remote Consoles. Deep Freeze Console 2 is restricted to 
Workstations 4–6 because it is only connected to the Remote Console on port 1500.

By assigning a unique port number to each Remote Console and each group of workstations, system 
administrators can control access to the workstations on a particular port using a password. Any 
authorized individual can connect to the Remote Console provided they know the port number, IP 
address, and password that the Remote Console is using. This allows administrators to have full access to 
each workstation in the enterprise while sub-administrators are limited to specific workstations.

Creating the Deep Freeze Server Service Manager

Remote Consoles are created using the Deep Freeze Server Service Manager. To create the Server Service 
Manager, run the Configuration Administrator (DFAdmin5.exe). On the Create Programs tab, choose 
Create Server Manager. The DF5ServerServiceManager.exe executable will be created.

If two sites are communicating with a lower bandwidth link, it may be advisable to place 
a Server Service Manager at each site to reduce network traffic during times when the 
workstations are not being controlled by the Enterprise Console. Having the Server Service 
Manager limited to the local network will prevent Deep Freeze related network traffic from 
consuming bandwidth on a continual basis.
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Using the Deep Freeze Server Service Manager

Double-click on the DF5ServerServiceManager.exe file to launch the Server Service Manager. It is used to 
setup the Remote Console on the server and configure the ports that it will communicate on.

Click Add to create a new entry. Enter a port number and tab over to enter a password. Repeat this process 
for as many ports as are required. A maximum of approximately 2000 ports can be entered.

Click Install Server to install the service. A dialog will display asking if the service should start 
automatically. Choose Yes to start the service now and when the workstation restarts. Otherwise, the 
service will have to be started manually with the Server Service Manager or the Windows Computer 
Management Console.

To make a change to the port number settings, stop the service by clicking Stop Server. Make the changes 
and click Start Server to restart the service.

The Deep Freeze Server Service Manager is an interface to administer the Remote Consoles 
running on the server. The Remote Consoles continue to run even if the server is logged off.
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Connecting to a Remote Console

Create a new Enterprise Console with the Configuration Administrator, using a different port than the 
other servers in the enterprise. Launch this new console.

Previously configured Remote Consoles will automatically be connected if they are available. If the 
password has changed, right-click on the Remote Console, select Remote Consoles ➜	Remote Console 
Management ➜	Reconnect to Remote Console, and type in the new password.

To add a new Remote Console, right-click on Remote Consoles in the Network and Groups section of 
the Enterprise Console and select Remote Consoles ➜	Remote Console Management ➜	Connect to Remote 
Console.

The Connect to Remote Console window will be displayed.

Enter a name in the Remote Console Name field. If a name is not entered, the IP address and port number 
of the Remote Console will be used as the name by default.

Enter the IP address of the Remote Console in the Remote Console IP field and the port number that the 
Server Service Manager is listening on in the Port # field. If the Server Service Manager is listening on 
multiple port numbers, only workstations listening on the specified port number will be shown.

Enter the password that was setup in the Server Service Manager in the Password field.

Click Connect to connect to the Remote Console.

To remove a Remote Console, right-click on its name and select Remote Consoles ➜	Remote Console 
Management ➜	Remove Remote Console From List. A Remote Console must be removed and then added 
again in order to change its name.
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Deploying Deep Freeze

After a customized installation program file has been created using the Configuration Administrator, Deep 
Freeze can be deployed to workstations using an Attended Install, Target Install, the Silent Install System, or 
as part of an imaging process. 

All background utilities and anti-virus software should be disabled and all applications should be closed 
prior to installation. These programs may interfere with the installation which could result in Deep Freeze 
not functioning correctly.

The workstation will restart after any type of installation is completed.

Deep Freeze must be in a Thawed state for any type of uninstall to succeed.

Any existing ThawSpace will be deleted during an uninstall if the option to retain existing 
ThawSpace was not checked in the Configuration Administrator, if the ThawSpace was 
not created with Deep Freeze Professional Version 5 or later, or if the ThawSpace is on a 
Windows 95/98/Me workstation.

Attended Install or Uninstall

Run the installation program file (DF5Wks.exe) on the workstation.

Click Install to begin the installation. Follow the steps presented, then read and accept the licence 
agreement. Deep Freeze will be installed and the workstation will restart.

Click Uninstall to uninstall Deep Freeze. Uninstall can only be clicked if Deep Freeze has previously been 
installed. If there is an existing ThawSpace, Deep Freeze will display a dialog asking if it should be retained 
or deleted.
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Silent Install or Uninstall

Deep Freeze can be rapidly installed to many workstations over a network using the Silent Install System. 
Any deployment utility that allows execution of a command line on a remote workstation can implement 
the Silent Install System. After the Silent Install is complete, the system will immediately restart. The 
command line has the following options:

Syntax Description
[/Install] Install Deep Freeze using installation file
[/Install/Seed] Install only the specified workstation seed file
[/Uninstall] Uninstall Deep Freeze
[/Uninstall/Seed] Uninstall Deep Freeze and leave the workstation seed installed
[/PW=password] Set a password during installation
[/AllowTimeChange] Allow system clock to be changed
[/Freeze=C,D,...] Freeze only drives listed (Thaw all others)
[/Thaw=C,D,...] Thaw only drives listed (Freeze all others)

Example Command Line: DF5Wks.exe /Install /Freeze=C /PW=password

In the example, the Deep Freeze installation program file is named DF5Wks.exe. Only the C: drive will be 
Frozen. Any other drives on the workstation will be Thawed. If the workstation only has a C: drive, the 
[/Freeze] switch can be omitted. A password (password) will be created. After executing the command, 
Deep Freeze will install and the workstation will restart Frozen and ready to use.

The Silent Install System will not work without the [/Install] or [/Uninstall] switch.

Deep Freeze must be in a Thawed state before [/Uninstall] can be used.

Silent Install or Uninstall using a Shortcut

Deep Freeze can be installed directly on a workstation without having to use the installation dialog box by 
using the following steps.

1. Locate the Deep Freeze installation program file (DF5Wks.exe) on the target workstation.
2. Right-click on the icon and choose Create Shortcut.
3. Right-click on the shortcut and choose Properties.
4. Edit the path of the Target field by typing /install or /uninstall at the end of the path.

Example Shortcut Target: “C:\Documents and Settings\DF5Wks.exe” /install

Double-clicking the new shortcut will result in the immediate installation or uninstallation of Deep Freeze 
followed by a restart of the workstation.

Deep Freeze must be in a Thawed state before /uninstall can be used.
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Network Install on Multiple Workstations

The Silent Install System can also be used to install Deep Freeze on multiple workstations over a network. 
If the workstations on the network use logon scripts, the scripts can be used to install Deep Freeze on 
all networked workstations automatically. All workstations will restart Frozen and ready for use after 
installation has completed.

Use one of the following command line syntaxes to create an install error report log file:

• \\Server Name\Share Name\DF5Wks.exe /Install > dfinstall.log
• \\Server Name\Share Name\DF5Wks.exe /install >> dfinstall.log

Install Over Existing Deep Freeze Versions

All existing Deep Freeze versions must be uninstalled prior to performing any new Deep Freeze 
installation.

Install Using Imaging

Deep Freeze Enterprise has been designed to work with all major imaging and desktop management 
software. Use either an Attended Install or the Silent Install System to install Deep Freeze on a master 
image.

Deep Freeze must be in a Thawed state before finalizing a master image. The workstation will require an 
additional restart after imaging for Deep Freeze to correctly detect the changes in disk configuration. If 
the workstations are imaged in an unattended mode, steps should be taken to ensure the workstations 
are restarted to allow the configuration to update. To return to the Frozen state after imaging is complete, 
set Deep Freeze to be Thawed after n number of restarts (in the master image) so that after n number of 
restarts, the workstation is automatically Frozen. Alternatively, use Deep Freeze Command Line Control to 
Freeze selected workstations.

Target Install Using Enterprise Console

Deep Freeze can also be deployed using a Target Install from the Enterprise Console.
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Using Deep Freeze

Workstation Logon

There are two ways to logon to Deep Freeze on a workstation. If the Deep Freeze icon is shown in the 
System Tray, hold down the SHIFT key and double-click the Deep Freeze icon. Alternatively, use the 
keyboard shortcut CTRL+SHIFT+ALT+F6.

Either method will bring up the logon dialog.

Enter the administrator password and click OK to logon to Deep Freeze.

Boot Control

The Boot Control tab is used to set the mode Deep Freeze will be in after the next restart. 

Boot Frozen will ensure that the workstation is Frozen the next time it is restarted.

Boot Thawed on next will ensure that the workstation is Thawed each time it is restarted for the next 
specified number of restarts. 

Boot Thawed will ensure that the workstation is Thawed each time it is restarted.

Select the radio button next to the desired choice and click OK for the changes to take effect.
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Network

The Network tab can be used to configure the network options on a workstation. 

The LAN and WAN radio buttons select between the LAN and the LAN/WAN method of communication.

When the WAN radio button is selected, a valid IP address for the Enterprise Console must be entered in 
the Console IP field. The default port number can be changed by unchecking Use Default Port and entering 
the desired port number.

For further information on network configuration, refer to the Enterprise Console Networks and Groups 
documentation.

One Time Passwords

A One Time Password (OTP) can be generated using the Configuration Administrator. The Configuration 
Administrator requires a token from the workstation in order to generate an OTP. The OTP Token for the 
workstation is located in the Deep Freeze logon dialog.

Refer to the Configuration Administrator documentation for more information about the One Time 
Password Generation System. An OTP can be used one or more times after it has been generated 
(depending on the options set when it was generated). All OTP passwords will expire at midnight on the 
day they were created.

An OTP must be used to logon to Deep Freeze if no passwords were created for the Deep Freeze 
configuration file.
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Using ThawSpace

ThawSpace is a virtual partition on a workstation that can be used to store programs, save files, or make 
permanent changes. All files stored in the ThawSpace will be saved after a restart, even if the workstation 
is Frozen. ThawSpace is only available if it was set to be created by the Deep Freeze Configuration 
Administrator.

Any existing ThawSpace will be deleted during an uninstall if the option to retain existing 
ThawSpace was not checked in the Configuration Administrator, if the ThawSpace was 
not created with Deep Freeze Professional Version 5 or later, or if the ThawSpace is on a 
Windows 95/98/Me workstation.

Permanent Software Installations, Changes, or Removals

Workstations must be Thawed for any permanent changes to take effect. Installation of software often 
requires one or more restarts to complete the installation. It is recommended that the Boot Control tab 
is used to allow the workstation to restart with Deep Freeze Thawed until installations or changes are 
finished.
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Deep Freeze Command Line Control (DFC.EXE)

The Deep Freeze Command Line Control (DFC) offers network administrators increased flexibility in 
managing Deep Freeze workstations. DFC works in combination with third party enterprise management 
tools and/or central management solutions. This combination allows administrators to update 
workstations on the fly and on demand.  
 
It is important to note that DFC is not a standalone application. DFC integrates seamlessly with any 
solution that can run script files, including standard run-once login scripts.

The DFC executable is installed in same directory as the Configuration Administrator:
C:\Program Files\Faronics\Deep Freeze Enterprise\Dfc.exe

DFC commands require a password with command line rights. OTP passwords cannot be used.

DFC Boot Control

Syntax Description
DFC password /BOOTTHAWED Restarts workstation into a Thawed state. Only works on Frozen 

workstations.
DFC password /THAWNEXTBOOT Sets up workstation to restart Thawed the next time it restarts. 

Only works on Frozen workstations. Does not force workstation 
to restart.

DFC password /BOOTFROZEN Restarts workstation into a Frozen state. Only works on Thawed 
workstations.

DFC password /FREEZENEXTBOOT Sets up workstation to restart Frozen the next time it restarts. 
Only works on Thawed workstations. Does not force workstation 
to restart.

DFC Status Query

Syntax Description
DFC get /ISFROZEN Queries workstation if it is Frozen. Returns 0 if Thawed. Returns 1 

if Frozen.

Configuration Update

Syntax Description
DFC password /CFG=[path] depfrz.rdx Replaces Deep Freeze configuration information. Works 

on Thawed or Frozen workstations. Password changes 
are effective immediately. Other changes require restart.
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DFC Return Values

On completion of any DFC command, the DFC will return the following values:

Value Description
0 SUCCESS or Boolean FALSE, for commands returning a Boolean result
1 Boolean TRUE
2 ERROR - User does not have administrator rights
3 ERROR - DFC command not valid on this installation
4 ERROR - Invalid command
5 - * ERROR - Internal error executing command

Batch File Example

The example below shows how to check for a specific error level using a DOS Batch file:

@ECHO OFF
DFC.EXE get /isfrozen
IF Errorlevel 5 GOTO Error5
IF Errorlevel 4 GOTO Error4
IF Errorlevel 3 GOTO Error3
IF Errorlevel 2 GOTO Error2
IF Errorlevel 1 GOTO Error1
IF Errorlevel 0 GOTO Error0

:Error5
Echo Errorlevel 5
Goto END

:Error4
Echo Errorlevel 4
Goto END

:Error3
Echo Errorlevel 3
Goto END

:Error2
Echo Errorlevel 2
Goto END

:Error1
Echo Errorlevel 1
Goto END

:Error0
Echo Errorlevel 0
Goto END

:END

Actions can be placed between the ECHO Errorlevel # statement and the Goto END statement for each of 
the detected error levels. To use this Batch file to automatically Thaw a Frozen workstation, the following 
section of the Batch file would have to changed:

:Error1
Echo Errorlevel 1
DFC.EXE password /BOOTTHAWED
Echo
Goto END

This section contains the actions that should 
be performed for each Errorlevel.

This section checks the Errorlevel that DFC 
provides to the operating system.
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Appendix A—Network Examples

Four examples of different network topologies running Deep Freeze Enterprise are discussed below. 

Example 1—LAN with Single Segment

Example 1 shows the simplest network topology. It consists of three workstations running Deep Freeze 
that are connected together by a hub or switch. A fourth computer is used as an administrative computer 
to run the Enterprise Console.

To setup the configuration, create a matching set of the programs DF5Wks.exe and DF5Console.exe using 
the Configuration Administrator.

Open the Configuration Administrator and create a new configuration file or open an existing file such as 
DepFrz.rdx, DF5Wks.exe, or DF5WksSeed.exe.

Click on the Network tab and select LAN mode. The default port number is set to 1971 but this can 
be changed to any appropriate port number. The port number is the listening port for the Enterprise 
Console. The Console will only see workstations that use the same port number.

Configure other options as required, then click on the Create Programs tab. Click on Create Enterprise 
Console and Create Full Workstation Installation to create the two files DF5Console.exe and DF5Wks.exe.

Run DF5Console.exe on the Enterprise Console computer. If the DF5Console.exe program was not created 
on the computer being used for the Console, the Console program must be activated the first time it is run 
using an OTP password generated by the Configuration Administrator.

Run DF5Wks.exe on each workstation. As each workstation completes the Deep Freeze installation and is 
automatically restarted, it will appear on the Console screen. The Console can now be used to control the 
workstation. 

Refer to the Enterprise Console documentation for further information.
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Example 2—LAN with Two Segments Connected by a Router

Example 2 shows a more complex network topology where two segments are connected by a router. The 
Deep Freeze Console and three workstations (Workstations 1, 2, and 3) are connected together on one 
segment. Three additional workstations (Workstations 4, 5, and 6) are connected on a second segment. 

The Deep Freeze configuration that works on the above topology consists of the same setup as described 
in Example 1 for the segment shown on the left (Workstations 1, 2, and 3). Workstations 4, 5, and 6 in 
the segment shown on the right must be installed with a Deep Freeze installation that has a different 
configuration.

In most cases, no configuration of the router will be necessary. The workstations on the right hand 
segment need to be configured in the LAN/WAN mode with the IP address of the Enterprise Console 
specified.

If the router is a NAT (network address translation) router, or there is a firewall between the two segments, 
the workstations on the right hand segment will need to be configured with the IP address of the router 
or firewall. The router or firewall will then need to be configured to forward traffic on the specified port to 
the Enterprise Console.

Open the DF5Wks.exe program (used on the left hand segment) in the Configuration Administrator. Click 
on the Network tab and select LAN/WAN mode. Set the IP number and ensure that the port number is the 
same as that used in the LAN configuration. 

Click the Create Programs tab. Click Create Full Workstation Installation and save the program under a 
different name to identify this configuration (e.g. DF5WksRouter1.exe).

Run this new program on Workstations 4, 5, and 6.

The Enterprise Console will display each of the new workstations as they automatically restart after 
installation.
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Example 3—Two Segment LAN with One Segment Connected by the Internet

Example 3 shows the same network described in Example 2, with the addition of a second router (Router 
2) that connects to the Internet. Workstation 7 is connected to Router 2 via the Internet.

For Workstations 1–6, the same settings as in Example 2 can be used. Workstation 7 will need to be 
configured with the external IP address of Router 2. Router 2 will need to be configured so that any traffic 
from Workstation 7 on the selected port will be forwarded to the Enterprise Console. This may require 
ports to be opened if a firewall is present.
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Example 4—Single Segment LAN with Two Enterprise Consoles

Example 4 shows a simple single segment network with two Enterprise Consoles. Console 1 is used to 
control Workstations 1, 2, and 3. Console 2 is used to control Workstations 4, 5, and 6. 

A Console communicates (listens) on a specific port number. Only one Console can monitor any one port. 
Therefore, in this example, Console 1 and Console 2 must be configured to communicate on different 
ports. Workstations 1, 2, and 3 must be configured to communicate on the same port as Console 1. 
Workstations 4, 5, and 6 must be configured to communicate on the same port as Console 2.
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